
VAMP

Administration and User Manual

Version 1.4.39

June 18, 2008

Visualization and Analysis of CGH arrays, transcriptome
and other Molecular Pro�les

Institut Curie Bioinformatics Unit



Contents

1 Introduction 3

2 Administration manual 4
2.1 System requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . 4
2.2 Installation and con�guration . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4

2.2.1 Installation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4
2.2.2 How to launch VAMP . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5
2.2.3 Con�guration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5
2.2.4 Data format . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6

3 User Manual 13
3.1 Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13

3.1.1 Top-left frame . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13
3.1.2 Bottom-left frame . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14
3.1.3 Main frame . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15

3.2 Basic functions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . 15
3.2.1 Data import . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16
3.2.2 Data display . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18
3.2.3 Search . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24
3.2.4 Visual rendering . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26
3.2.5 Print . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28
3.2.6 Save and load . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30

3.3 Data analysis . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. 31
3.3.1 Manual analysis . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31
3.3.2 FrAGL (Frequency of Amplicon, Gain and Loss) view . . . .. . . . . . . 32
3.3.3 Finding common alterations among a collection of CGH-array pro�les . 34
3.3.4 Clustering pro�les . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39
3.3.5 Comparing pro�les . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41
3.3.6 Confrontation with sample annotation . . . . . . . . . . . . .. . . . . . 42
3.3.7 Synteny analysis . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 43
3.3.8 Confrontation with Genome Annotation . . . . . . . . . . . . . . . . . . 45
3.3.9 Signal Histogram . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47
3.3.10 Di�erential Analysis . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 48
3.3.11 Correlation Analysis . . . . . . . . . . . . . . . . . . . . . . . . . .. . . 52

4 Analysis example - Bladder Cancer 55
4.1 Introduction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 55
4.2 Import the genomic pro�les . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 55
4.3 Minimal Alteration computation . . . . . . . . . . . . . . . . . . . . . . . . . . . 56

4.3.1 Parameters settings . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . 56
4.3.2 Visualization of the regions . . . . . . . . . . . . . . . . . . . . .. . . . 58

1



4.3.4 Candidate genes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 59
4.4 Genome/Transcriptome comparison . . . . . . . . . . . . . . . . . .. . . . . . . 61

5 Analysis example - Colon Cancer 63
5.1 Introduction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 63
5.2 Import the genomic pro�les . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 63
5.3 Frequency alteration computation . . . . . . . . . . . . . . . . . .. . . . . . . . 64

5.3.1 Computation for each dataset . . . . . . . . . . . . . . . . . . . . .. . . 64
5.3.2 Comparison of the frequency between the two datasets .. . . . . . . . . 65

6 Availability 68

7 How to cite us? 69

8 Annexes 72
8.1 Main con�guration XML �le . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72
8.2 Sample user con�guration XML �le . . . . . . . . . . . . . . . . . . . . . . . . . 73
8.3 Import XML �le . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 74
8.4 CGH array XML �le . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 75
8.5 Transcriptome array XML �le . . . . . . . . . . . . . . . . . . . . . . . . . . . . 75

2



Chapter 1

Introduction

VAMP is a graphical user interface for the Visualization andAnalysis of array-CGH, transcrip-
tome and other Molecular Pro�les. VAMP was primarily developed for visualization and analysis
of tumor sample array-CGH pro�les. Several types of visualization are proposed: for example
classical CGH karyotype view or the genome-wide multi-tumor comparison views are available
and allow the user to easily compare di�erent arrays. Additional information concerning each
clone or DNA region can be retrieved interactively from di�erent public databases through ex-
ternal links. VAMP allows the user to confront the display ofdi�erent types of molecular pro�les
such as array CGH pro�les, transcriptome arrays, SNP (Single Nucleotide Polymorphism) ar-
rays, Loss of Heterozygosity results (LOH), and Chromatin ImmunoPrecipitation arrays (ChIP
chips). Many functions for analyzing CGH or other data are provided within the interface,
including looking for recurrent regions of alterations, confrontation of genome data with tran-
scriptome data or clinical information, clustering, synteny visualization, . . . VAMP consists of
a graphical interface written in Java 1.4.2. The software retrieves information from XML �les,
making it easy to install it in any laboratory.

VAMP is provided with public data sets (Snijders et al., 2001, 2005; Gysin et al., 2005;
Douglas et al., 2004; de Leeuw et al., 2004; Nakao et al., 2004; Veltman et al., 2003; Pollack et al.,
2002) as examples which can be directly used. This document describes the installation, the
con�guration and the main functions of VAMP.

Note that some movies present the main functions of VAMP for basic functions, data Analy-
sis, synteny analysis; they are available at the following URL http://bioinfo.curie.fr/vamp/doc.
An HTML version of this manual with full size images also available at:

http://bioinfo.curie.fr/vamp/doc/userManual/

The manual is organized as follows:

� Chapter 2 describes the installation and the administration of the software

� Chapter 3 presents the functionnalities of the software

� Chapters 4 and 5 present two detailed analyses on real datasets
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Chapter 2

Administration manual

2.1 System requirements

VAMP is a Java applet and therefore the Java Runtime Environment (JRE) must be installed
on your computer before running VAMP. We recommend to use Java 1.5.0 (for better rendering
and performances), see http://java.sun.com/j2se/1.5.0/for download.

To visualize a large number of pro�les simultaneously the java parameters regarding memory
allocation must be correctly set.

For example, if your computer disposes of 1 Gb of RAM memory the java virtual machine
memory can be set with the following parameters:

Java virtual machine parameter setting : -Xms400000000 -Xmx800000000

If you have more (or less) memory, these parameters must be adjusted accordingly. 512 Mb
of memory is considered as a minimum, and we strongly recommend to dispose of 1Gb.

-Xmsde�nes the minimal memory size allocated to the java virtualmachine and-Xmxde�nes
the maximal memory size (note that the-Xmxcan not exceed the size of the RAM memory).
In the example below the memory allocation ranges from 400Moup to 800Mo.

With these parameters the users can load up to 700 microarrays (each with 3500 probes)
simultaneously.

For more details please visit : http://bioinfo.curie.fr/t utorial/vamp/Java-con�guration.html

2.2 Installation and con�guration

2.2.1 Installation

VAMP can be installed either in standalone version or in intranet server version:

standalone version (Windows): once you have retrieved and extracted the VAMP.tar.gz
�le, just copy the VAMP directory into the C: directory. If you want to install the software
in a di�erent directory you have to replace the default pathC:/VAMPwith the new path
in the following con�guration �les: cgh.html , configuration/xml/syscfg.xml and
configuration/xml/print-report.xml .

standalone version (Mac OS X/Unix/Linux): once you have retrieved and extracted the
VAMP.tar.gz �le, just copy the VAMP directory in any directo ry. You have to replace the
default path C:/VAMPwith your new path in the following con�guration �les: cgh.html ,
configuration/xml/syscfg.xml , configuration/xml/print-report.xml . For exam-
ple if you have copied the VAMP directory into/usr/local you replacefile:///C:/VAMP
with file:///usr/local/VAMP .
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copy the VAMP directory into the root directory of your webserver (for example in the
directory /http/hosted/myHome.com/html of your apache server). The following �les
should be modi�ed : cgh.html, con�guration/xml/syscfg.xml, con�guration/xml/print-
report.xml, in order to replace the default pathC:/VAMPwith the new path. For example
let us assume you have copied the VAMP directory into/http/hosted/myHome.com/html .
Then replacefile:///C:/VAMP with http://myHome.com/VAMP.

Note that the standalone version uses the �le protocol whereas the intranet server version
uses the http protocol.

2.2.2 How to launch VAMP

In the case of a standalone version, just open the �le index.html in the VAMP directory and in
the case of an intranet server version just open the urlhttp://myHome.com/VAMP.

2.2.3 Con�guration

There are two con�guration �les in VAMP: the administrator c on�guration �le which is the
most important and the user con�guration �le.

Administrator con�guration

The main con�guration �le ( syscfg.xml )can be modi�ed by the administrator. It contains the
initialization of the resources (i.e. access path to the data, url address to your favorite public
databases, cytogenetic banding informations, ...) which allows VAMP to be launched correctly.
The xml data �le need to be copied into the root directory de�ned in the tag:< Parameter
key="importData:baseURL" value="�le:///yourRootDirec tory/" > as described below.

A sample administrator �le is given in the Annexes (see 8.1):it can be modi�ed to customize
the contextual menus regarding the information of the clones, the transcriptome probes, SNPs,
...

User con�guration

It is possible to customize the visual rendering of VAMP. Thetop-left panel provides a user-
friendly interface for customizing the most important visual features (see section 3.2.4). Once
the user has chosen his favorite parameters, he can save his con�guration into an XML �le,
using File ! Configuration ! Save(seeFigure 2.1 )

Any saved con�guration can be restored usingFile ! Configuration ! Load.
This XML con�guration �les also stores features that cannot be accessed directly within

VAMP menus. To modify such features, just edit the XML con�guration �le. For example, if
you change line

<CanvasBG>ccccff</CanvasBG>

to :

<CanvasBG>GREY</CanvasBG>

the main frame background color will switch from light blue to grey.

A sample user con�guration �le is given in the Annexes (see 8.2).
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Figure 2.1: File ! Configuration ! Save.

2.2.4 Data format

The data format which is used in VAMP is XML (eXtensive MarkupLanguage). Two types of
XML �le are necessary to run VAMP:

� Array �les which contain the information related to a molecular pro�le: for each experi-
ment there is a �le which stores both array-level information (e.g. patient ID, number of
clone, date of experiment, ...) and clone-level information (e.g. clone name, ratio value,
chromosome number, location, ...). The Array �les are organized according to the follow-
ing hierarchy: team! projects ! Array �les. Each team may contain several projects
and each project may contain several array �les.

� the Import �le which contains the list of projects and arrays that can be loaded within
the VAMP, as described in section 3.2.1

VAMP distribution provides two scripts that generate theseXML �les automatically, as
described in section 2.2.4:

vampTxt2xml generates Array XML �les from CSV (comma separated values) �les.

Files are available from the Download :

vampTxt2xml:

http://bioinfo-out.curie.fr/vamp/doc/script/vamp txt2xml

Array XML �les:

http://bioinfo-out.curie.fr/vamp/doc/data/xml/dougl as/Cancer3.xml

CSV �les:

http://bioinfo-out.curie.fr/vamp/doc/data/txt/dougl as/Cancer3.csv

The xml data �le need to be copied into the root directory de�ned in the tag:

< Parameter key="importData:baseURL" value="�le:///your RootDirectory/" > as de-
scribed in con�guration �le syscfg.xml, section 2.2.3.
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directory.

Files are available from the Download :

vampProject2import :

http://bioinfo-out.curie.fr/vamp/doc/script/vampPro ject2import

Import XML �le:

http://bioinfo-out.curie.fr/vamp/doc/data/import data public xml/public.xml

In case you need to generate yourArray �les without using these scripts, subsection 2.2.4
provides a detailed description of corresponding XML tags.

Scripts for automated data generation

Array �les can be generated by the scriptvampTxt2xml. As an input, this script takes csv
(comma separated value) text �les. The �eld names must correspond to the tags listed in
section 2.2.4 and the �le must be ordered by chromosome and position. We give an example of
such an input �le below:

Y,X,Chr,Name,Smt,Bkp,Out,Gnl,Weight
1.658040e-01,3247817,1,RP4-785P20,-0.020635750,0,0, 0,NA
1.316050e-01,4487199,1,RP1-37J18,-0.020635750,0,0,0 ,NA
-9.597111e-02,5877818,1,RP11-49J3,-0.020635750,0,0, 0,NA
3.588748e-02,7071571,1,RP3-438L4,-0.020635750,0,0,0 ,NA
-1.012979e-01,7653186,1,RP11-338N10,-0.020635750,0, 0,0,NA
-1.728830e-01,9146799,1,RP3-510D11,-0.020635750,0,0 ,0,NA
5.558425e-02,10087260,1,RP4-575L21,-0.020635750,0,0 ,0,NA
.
.

This script outputs array �les in the following directory structure:

� a �rst subdirectory structure contains pan-genomic pro�leof each array and chromosomic
pro�le of all arrays in the project [project name] (this subdirectory structure is used for
Import functions)

/[project_name]/array/[array_name].xml
chr/chr01.xml
.
.
.
chr/chrY.xml

� a second subdirectory structure contains chromosomic pro�le of all arrays in all projects
( this subdirectory structure is used for Save and Load functions)

/all/chr01/[array_name].xml
.
.
.
chrY/[array_name].xml
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ous directory structure. An example of such an import �le is given in the Annexes (see 8.3).

Array �les

An Array �le typically contains clone or probe-level information for one or more chromosome
of one or more samples. It consists of anArraySet , in which one ore moreArray elements
are embedded. Each of theseArray elements regroupsObj elements, which store probe-level
information for one particular sample.

The corresponding XML �les has the following hierarchical structure:

<?xml version='1.0' encoding='iso-8859-1'?>
<ArraySet>

<SetName>Name</SetName>
<Array>

// Array Properties
<Obj>

// Obj Properties
</Obj>
<Obj>

// Obj Properties
</Obj>
.
.
.

</Array>
<Array>

// Array Properties
<Obj>

// Obj Properties
</Obj>
<Obj>

// Obj Properties
</Obj>
.
.
.

</Array>
.
.
.

</ArraySet>

We provide a short description ofArray and Obj properties:

Array properties The following tags are mandatory:

<Organism>: species

<Project> : project name

<Name>: array name
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associated with the following types:CGH, Trs, LOH, SNP, and ChIP, as described in table
2.1

<Ratio> : the type of the signal value: ratio (M) or log ratio (L).

<Url> : the physical localization of the XML �les which contains thearray data for each chromo-
some (tag<Chr>); these Urls are used by the software for saving analysis (save command
of File menu) and restore any saved analysis (load command ofthe File menu).

The following tags are optional, but �lling them allows one to identify the patient, and
therefore to link together pro�les from the same patient, e.g. array-CGH and transcriptome
data:

<ProjectId> : identi�cation of the project

<NumHisto>: histological number (which corresponds to a unique patientID)

The tag <SampleAdditionalData> links array �les with additional data (e.g. clinical data)
that are stored for a given sample in an XML �le, as described in section 2.2.4.

Any other tag may be added in the<Array> description. They will be listed in the Info
Panel of the bottom-left frame (�gure 3.3), and will be takeninto account by theSearch Arrays
function (section 3.2.3).

Object properties Object descriptions are encapsulated as follows:

<Obj>
<Properties>

<Type>
// Obj Type

</Type>
// other Obj Properties

</Properties>
</Obj>

Tag <Type>describes the object type. Any type description may be used,but the default
VAMP functions are associated to the following types :Clone, Probeset , Microsat , SNP, and
Probe.

There is a default type for the objects of an array, which depends on the array type as
summarized in Table 2.1.

Data type Array type Object type
CGH-array CGH Clone
transcriptome arrays Trs ProbeSet
Loss Of Heterozygosity data LOH Microsat
Single Nucleotide Polymorphism arrays SNP SNP
Chromatine ImmunoPrecipitation arrays ChIP Probe

Table 2.1: Default object types in the di�erent types of arrays
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tory. Some others are required to use some of the VAMP functions. The list of mandatory or
required object tags depends on the array type. In the two following paragraphs we describe
the mandatory and optional tags we used for the two most widely used data: array-CGH data
and transcriptome array data.
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<X>: genome position (integer)

<Y>: ratio or log2-ratio value (real), consistently with the value of the array-level tag<Ratio>:
Mfor ratio or L for log2-ratio.

<Chr> : chromosome name (1, 2, . . X, Y)

<Name>: clone name (e.g.RP11-84M16)

The remaining tags are not mandatory, but they are required to activate some of the VAMP
functions, related to DNA copy number analysis:

� functions related to DNA copy number analysis:

<Smt>: smoothing value (smoothed value of signal for a Clone)

<Bkp>: breakpoint (a DNA breakpoint has been detected after this clone)

<Out> : outlier (clone with signal signi�cantly di�erent from its n eighbors: values are
either -1 or 1)

<Gnl> : clone status : amplicon, gain, normal, loss, and double loss(values are -10 for
double loss, -1 for loss, 0 for normal, 1 for gain, 2 for amplicon)

These values may be calculated for example with the GLAD algorithm (Hup�e et al., 2004)

The clone size (tag<Size>, value in bp) is required for X-zooming in up to the clone scale (not
available in the public data sets provided with this distribution).

Any other tags may be added in the<Obj> description. They will be listed in the Info Panel
of the bottom-left frame (�gure 3.3), and will be taken into account by the Search Elements
function (section 3.2.3).

A sample XML �le for CGH array data is given in the Annexes (see8.4).

Transcriptome array data The following four tags are mandatory for describing transcrip-
tome probe sets:

<ObjectId> : the name of the object

<PosBegin>: start position of the probe set on the genome

<PosEnd>: end position of the probe set on the genome

<Signal> : signal value

The following �elds are optional; they provide hypertext links towards public databases
within VAMP.

<Source> : origin of the object (IMAGE, GenBank, ...)

<SourceID> : object identi�cation for the public database

Any other tags may be added in the<Obj> description. They will be listed in the Info Panel
of the bottom-left frame (�gure 3.3), and will be taken into account by the Search Elements
function (section 3.2.3).

A sample XML �le for transcriptome array data is given in the Annexes (see 8.5) .
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Finally we describe the data format used for adding sample annotation data to molecular pro�les.
Clinical data descriptions are encapsulated as follows:

<SampleAdditionalData>
<ClinicalData>

<Age>72</Age>
<Sex>Male</Sex>
<Stage>2</Stage>
<Location>Left</Location>
<Bat26>Stable</Bat26>

</ClinicalData>
</SampleAdditionalData>

Note that any property speci�ed by <ClinicalData> will be used in VAMP within functions
related to 'Sample Annotation' (see section 3.3.6); In the example above, the properties<Age>,
<Sex>, <Stage>, <Location> , <Bat26> were not previously known by VAMP but they will be
taken into account by VAMP.
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Chapter 3

User Manual

3.1 Overview

A typical VAMP window is divided into three areas (�gure 3.1): the main frame consists of the
graphical display of the pro�les; the top left frame controls zoom, search and drawing options;
the bottom left frame o�ers the choice between textual information on the object under the
mouse pointer, or context information, called MiniMap.

Figure 3.1: Typical VAMP window.

3.1.1 Top-left frame

The top-left frame is composed of several tabs controlling zooming, search and drawing options
(seeFigure 3.2 ). These functionalities are described in details in subsections 3.2.3 and 3.2.4.
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Figure 3.2: Top-left Frame - Zooming tab is selected.

3.1.2 Bottom-left frame

The bottom left frame o�ers the choice between textual information on the object under the
mouse pointer, or context information, called MiniMap (�gure 3.3).

The information panel allows to retrieve array-level information (e.g. project id, patient id),
or clone-level information (e.g. ratio, chromosome, position).

The MiniMap panel allows the user to easily visualize any clone name and its chromosome
location. Right-clicking on one of the cytogenetic bandingallows to open a contextual menu
linking to public databases. This menu can be con�gured as described in section 2.2.3.

Figure 3.3: Info Panel (left) and Mini Map Panel (right).
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The main frame (seeFigure 3.4 ) provides various ways of visualizing molecular pro�les, which
are described in details in subsection 3.2.2.

Figure 3.4: Main frame - Graphic Panel.

3.2 Basic functions

All user actions are accessible either through a Menu on the menu-bar, or through pointing to
or clicking objects. When using VAMP, the session can be saved in local XML �les. Reloading
the �le later on allows the continuation of the analysis within the context of the previous work,
or allows the exchange of results and data with colleagues. All user preferences can also be
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to any other window, the rendering being automatically adapted (e.g. from a dot plot view to
a karyotype view). An advanced printing function is o�ered (see 3.2.5 for details).

3.2.1 Data import

Once XML array �les and import �les have been generated (see 2.2.4), data can be imported
into VAMP, as shown in �gure 3.5.

After selecting a project (�gure 3.6), the user can import either pan-genomic pro�les (3.7)
or chromosome pro�les (3.8) for the same project or from di�erent projects.

Figure 3.5: Import data.

Figure 3.6: Select a project.
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Figure 3.7: Import pan-genomic pro�les.

Figure 3.8: Import chromosome pro�les.
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VAMP currently o�ers several types of visualization that can be displayed in the main frame:
(i) Pro�le View, (ii) Karyotype View, (iii) Dot Plot View, (i v) List View. These views all allow
simultaneous visualization of several pro�les (the only limitation is the memory size of the
computer running VAMP, or more precisely, the memory allocated to the Java virtual machine
(see section 2.1): for example with an 800 Mb Java virtual machine memory, 700 microarrays
(each with 3500 probes) can be loaded simultaneously).

Whatever view is chosen, the pro�les can be represented in Genomic mode or Chromosome
mode. The Genomic mode simply depicts the pro�les along all the concatenated chromosomes.
It is the most usual representation, and allows comparison of pro�les from di�erent samples or
comparison of di�erent types of pro�les from a given sample.The Chromosome mode is similar
to the Genomic mode except that it only displays one particular chromosome. It is also possible
to merge several chromosomes and to represent those chromosomes useful for the study.

Pro�le View

The Pro�le View can display the pro�les as points, barplots or curves (seeFigures 3.9 and
3.10). The Pro�le View can also display symbols for chromosome telomeres and centromeres,
and can show the results of CGH ratio statistical analysis (e.g. breakpoints, or smoothed signal
values, ...) (seesection 3.2.2 ).

Figure 3.9: Views ! Current View ! Point View - After importing the genomic pro�les
(see section 3.2.1), it is possible to switch from one type ofrepresentation to another.

The main frame can be split into two frames (seeFigure 3.11 ). The upper frame can, for
example, contain a pro�le for reference when browsing a collection of pro�les in the lower frame.
The two frames have separate control of Y-scale and Y-scrolling, but have the same X-scale and
X-scrolling.
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Figure 3.10:Pro�le View (Point View).

Figure 3.11:Views ! New View! Double View ! Point View - The user can open a new
double view (seeFigure 3.47 ).
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The Karyotype View (seeFigures 3.12 and 3.13) displays pro�les with the classical CGH
rendering: vertical representations of chromosomes with cytogenetic banding and contiguous
representation of sample pro�les.

Figure 3.12: Views ! Simple View ! Karyotype Classic View - The user opens a new
Karyotype Classic View.

Figure 3.13:Karyotype Classic View - Right-clicking on a clone, chromosome or array, pops
up a contextual menu.
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The Dot Plot View (see Figures 3.14 and 3.15) does not consider the microarray probe
positions on the genome, but only their ranks.

Figure 3.14: Views ! Simple View ! DotPlot View .

It displays a collection of samples as a heat map (seeFigure 3.15 ) based on the level of
signal for each clone or using theGain / Loss Color Code (Figure 3.18 ).

Figure 3.15: Dot Plot View.
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This view (seeFigure 3.16 ) lists the names of all the arrays currently loaded and can beused
for selecting or keeping track of the data under study.

Figure 3.16:Views ! Current View ! List View .

Display additional features

Additional features regarding array CGH pro�les can be displayed within VAMP, provided
that these features are available in theArray XML �les (see2.2.4). For example, the pro�les
could have been preprocessed by any segmentation algorithmlike GLAD (Hup�e et al., 2004),
the following additional features are available within themenu View ! Current View (see
Figure 3.17 and 3.18):

� Gain / Loss Color Code: each clone is colored according to its status (loss in green,
normal in yellow, gain in red and amplicon in blue)

� Show Breakpoints: a vertical red dashed line is plotted and represents the breakpoint
location

� Show Smoothing Lineand Show Smoothing Points: the piecewise constant function es-
timated by the segmentation algorithm is plotted

� Show Outliers : outliers (see page11 for a de�nition of outliers) are black circled.
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Figure 3.17: Views ! Current View .

Figure 3.18:Additional information with Gained/Lost Color Codes , Show Breakpoints,
Show Smoothing Lines, and Show Outliers .
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A function is available to search for any array-level of probe-level information in the data.

Search for arrays

The user can search for arrays matching his criterion, such as: Name = Cancer11(seeFig-
ure 3.19 ).

Figure 3.19: Search Arrays Panel.

The �rst array matching the search criterion is highlighted in the main frame (seeFig-
ure 3.20 ).

Figure 3.20: Search Arrays Panel and array highlighted in the main frame.
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The user can search for elements (or objects, this refers to the probes on the array, e.g. clones)
matching his criterion, such as:Name = RP11-140M23(seeFigure 3.21 ).

Figure 3.21: Search Elements Panel.

The �rst clone matching the search criterion is highlightedin the main frame. It is possible
to simply pass from the �rst clone found to the following. Three check buttons control the
search output (Pin up info , Edit properties , Put landmark) (seeFigure 3.22 ).

Figure 3.22: Search Elements Panel.
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Zoom

The user can zoom in or zoom out on molecular pro�les (zoom scale is logarithmic) (seeFig-
ure 3.23 ). Fit checkboxes force the horizontal and/or vertical scale to �tthe window size.

Figure 3.23: Zooming Panel.

Color codes

By default, points or barplots are colored according to the signal intensity (generally using ratios
of the two channels or log-ratios) using a continuous scale from red to yellow to green. The user
can easily change the thresholds and colors of the clone ratios, either for one particular array
(Local option) or for all arrays displayed (Global option) (seeFigure 3.24 and 3.25).

Figure 3.24:Color Legend Panel.

For each of the views described in section3.2.2, molecular pro�les can be colored according
to the results of array-CGH data analysis (see section3.2.2).
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Figure 3.25:Color Legend Panel.

X and Y scaling

The user may change the vertical range, either for one particular array (Local option) or for
all arrays displayed (Global option) (seeFigure 3.26 and 3.27).

Figure 3.26:Y Range Panel.

In the following example the user widened the visible range,so that all amplicons are dis-
played.
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Figure 3.27:Y Range Panel.

3.2.5 Print

An advanced printing function is o�ered, either in visible mode (only the pro�les that are visible
on the screen are printed), or in global mode (all pro�les in the view are printed). A template is
o�ered for de�ning the output of the printing (this can, for example, include several frames in
an arbitrary composition, to which text or images can be added). It can be used for de�ning and
printing standardized outputs. The user can also interactively monitor the print preferences.
In any case, the print function is WYSIWYG through an intermediate preview which can be
edited by the user. The print menuFile ! Print ! Standard Report Template opens the
default printing template (seeFigure 3.28 ), and allows the user to print or export into PNG
format.

Figure 3.28: File ! Print ! Standard Report Template
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use. After switching to 'Edit' mode (by clicking on the Edit button), you can add (or remove)
several types of objects, such as text, molecular pro�les, images, ... These objects can be dragged
and dropped inside the template (seeFigure 3.29 ).

Figure 3.29: Customized template - A minimap has been added to the standard template.

The menu File ! Print ! Print preview loads the last used template.
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The session can be saved in XML �les. Reloading the �le later on allows the continuation of
the analysis within the context of the previous work, or the exchange of results and data with
colleagues (seeFigures 3.30 and 3.31).

Figure 3.30: Save and Load menus

Figure 3.31: Save dialog window.

There are three possibilities to load a saved session:in New View, replace in Current
View or add in Current View .
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The VAMP software allows a large variety of analysis to be performed by the users. Some of
the tools provided are pro�le-speci�c, e.g. tools dedicated to array-CGH or transcriptome data
analysis. Other generic tools can be used with any type of molecular pro�le. You will �nd below
a list of the main analysis tools available within VAMP.

3.3.1 Manual analysis

Among the numerous functions of VAMP, the user has the possibility to put his own marks
and regions. This is done by right-clicking on clone/probe element under the mouse pointer of
any molecular pro�le. A menu appears as shown inFigure 3.32 allowing various actions to be
performed:

Figure 3.32: Contextual Menu - The user can easily put landmarks and regions of biological
interest.

Within the contextual menu, it is possible:

Center on Clone/Probe: to center the pro�le around the current position.

Put landmark: to draw a vertical bar trough all the pro�les to de�ne a locus.

Put begin landmark , Put end landmark: to draw a region over the set of pro�les.

External links : to retrieve any information from public or local databases.It is possible to
add your favorite database (seesection 2.2.3 ).

The user can customize colors by right-clicking onto landmarks and regions and then using
Set colors for a better visualization (seeFigure 3.33 ).
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Figure 3.33: Customize Analysis - Choose your favorite color.

3.3.2 FrAGL (Frequency of Amplicon, Gain and Loss) view

The identi�cation of systemic alterations within a set of tumors is central to the analysis of CGH
array data for two reasons. Firstly, it can pinpoint new candidate genes, as tumor suppressor
genes and oncogenes are thought to be present in regions of loss and gain, respectively. Secondly,
some alterations may be signi�cantly correlated with clinical phenotype and may therefore be
useful for diagnosis and prognosis. The simplest way to identify informative regions is to work
at the probe level. For each probe, the fraction of tumors with gains and losses over the dataset
is computed (seeFigures 3.34 ) and displayed in the FrAGL view (seeFigures 3.36 ).

Figure 3.34: Tools ! FrAGL ! Compute - Open dialog the FrAGL dialog box.
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Based on Ratio: Probe status is de�ned with the Color Legend thresholdsNormalMin, Nor-
malMax and Amplicon (seeFigures 3.24 )

Based on Status: Probe status is de�ned with Gained / Lost Color Codes (GNL)

Type of alterations: For gain region the user can search for either only Gain, either only
Amplicon or merge Gain and Amplicon

Color bars ratio average: Color bar corresponds to the ratio average of probes with the
alteration

Color bars con�dences: Color bar corresponds to the percentage of pro�les without missing
values

Minimum support of alterations: Probe with a frequency less than this number are dis-
carded

Minimum value of con�dence: The con�dence corresponds to the percentage of pro�les
without missing values. Probe with a frequency which have been computed with less
than this number are discarded

Results: The frequency is displayed in apro�le view (seeFigures 3.36 ) or in a Karyotype
classical view(seeFigures 3.13 )

Report: The frequency are saved in a HTML or CSV �le

Figure 3.35: FrAGL dialog - Di�erent FrAGL options are available.
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Figure 3.36: FraGL pro�les - FrAGL (Frequency of Amplicon, Gain and Loss) view. The
values correspond to the percentage of gained and lost clones identi�ed with GLAD over the
whole dataset from Patil et al. (2005)

3.3.3 Finding common alterations among a collection of CGH- array
pro�les

Instead of looking for individual probes carrying genome alterations, it is often fruitful to con-
sider the geography of the genome and to look for whole regions. Rouveirol et al. (2006) have
described algorithms for �nding common alterations. Two algorithms are proposed within
VAMP. It is necessary that breakpoints, gain, loss and amplicon regions have been previously
detected by any algorithm (Hup�e et al., 2004). We propose two di�erent approaches to identify
such regions of biological interest:

� Tools ! Genome Alteration ! Compute: Minimal Alterations are extracted by inter-
secting the pro�les of many tumors and looking for a su�cient number of alterations in
the tumors (this parameter is set by the user) over the smallest possible region of the
pro�le (see Figures 3.37, 3.38 and 3.39 ).

� Tools ! Genome Alteration ! Compute: In a given tumor, an alteration is bounded by
two extremities, which can be a breakpoint or a chromosome end; when an alteration
is present in a su�cient number of tumors with the same extremities, it is a recurrent
alteration (seeFigures 3.40, 3.41 and 3.42 ).

For both Recurrent Alterations and Minimal Alterations, the user has to set theMinimum
support required, that is the minimum number or percentage of tumorsshowing the alteration
for considering it as signi�cant.
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Figure 3.37:Tools ! Genome Alteration ! Compute- The user opens a new dialog window
to set the parameters for Minimal Alterations.

Figure 3.38: Minimal Alterations - Choose Minimal regions - At least 50% of the pro�les
must share the same alterations.

35



Figure 3.39: Minimal Alterations - Results : the minimal alterations are drawn in red for
gain, green for loss. Here there is only one loss region.
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Figure 3.40: Tools ! Genome Alteration ! Compute- The user opens a new dialog window
to set the parameters for Recurrent Alterations.

Figure 3.41:Recurrent Alterations - Choose Recurrent regions - At least 12 out of 30 pro�les
must share the same alterations.

37



Figure 3.42:Recurrent Alterations - Results : the recurrent alterations are drawn in red for
gain, green for loss. Here there is only one loss region.
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Clustering is a general technique for unsupervised data classi�cation widely used in microarray
data analysis. A VAMP function o�ers the possibility to perform a hierarchical clustering
(Kaufman and Rousseuw, 1990) on the array CGH pro�les (seeFigure 3.43 ).

Figure 3.43:Tools ! Clustering ! Compute - The user can open a new window of dialog
for clustering.

The clustering can be performed on di�erent variables (seeFigure 3.44 ):

Probe LogRatio: The Probe LogRatio values of the whole genomic pro�le are used

Probe Smoothing: The Probe smoothing values (i.e. the results of a segmentation algorithm)
of the whole genomic pro�le are used

Probe Status: The Probe statuses (i.e. the results of a segmentation algorithm) of the whole
genomic pro�le are used

Regions Status: Regions either selected manually or identi�ed by our algorithm (see sec-
tion 3.3.3 ) are used

Exclude sexual chromosomes .

Di�erent options are available:

Distance metric: Euclidian, Pearson and Manhattan distance are available

Group metric: Ward, Single linkage, Group Average and Complete linkage are available

VAMP displays the results as a cluster view including a heat map and the trees resulting
from the clustering algorithm (Figure 3.45 ).
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Figure 3.44: Clustering pro�es - Di�erent clustering options are available.

Figure 3.45: VAMP interface - Dotplot view of array-CGH pro�les (middle panel), and
dendrogram resulting from a hierarchical clustering (right panel). In between, color-coded
clinical information about the samples, with a legend (bottom left). Data from Nakao et al.
(2004)
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VAMP proposes several data manipulation procedures for thepro�les such as loading any type of
pro�le (CGH, expression, LOH, ChIP chip) for a given sample.A typical application of VAMP
is the simultaneous visualization of the DNA alterations and gene under- and over-expression in
a region (seeFigures 3.46 and 3.47). In the case of one-color microarrays (such as A�ymetrix)
the user can de�ne a reference pro�le and compute the ratio with a test pro�le: he can easily
compare the ratio of gene expression with the DNA alteration.

Figure 3.46: Transcriptome Load - The user can load expression pro�les The user can load
and visualize one expression pro�les which is connected to Array-CGH.

In the example below we compare array-CGH (top pro�le) versus transcriptome ratio (second
pro�le in descending order), computed for A�ymetrix U95 array of a bladder tumor sample and
of a reference sample. This confrontation pinpoints the probable implication of the oncogene
cyclin D1 in this tumor. The third and fourth pro�les in descending order correspond to a
reference pro�le (average normal bladder tissue pro�le) and the pro�le of the tumor under
study, respectively. The second pro�le is the ratio of the fourth to the reference pro�le.

Figure 3.47: CGH vs Transcriptome. An icon at the left of each pro�le shows the type of
loaded pro�le.
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Clinical data, or any other sample annotations present in the additional XML �les (see sec-
tion 2.2.4 ) can be visualized in the interface or used for �ltering tumors or for sorting them
(the link between additional data and molecular pro�le is based on the XML tag <NumHisto>
representing a unique patient ID (seesection 2.2.4 ). To add any clinical properties in the
current view, just do the following:

� open the dialog to add clinical properties (seeFigures 3.48 )

� choose the properties you want to display (seeFigures 3.49 )

Figure 3.48: Tools ! Sample Annotations ! Clinical property - The user opens a dialog
box where he can easily choose the available clinical properties.

Figure 3.49: Sample annotations - The user chooses clinical properties to be visualized.

This data can be visualized as color-coded bars in an annotation frame on the left of the
pro�les, and can be easily compared with a clustering result(Figure 3.50 ).
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Figure 3.50: VAMP interface - Dotplot view of array-CGH pro�les (middle panel), and
dendrogram resulting from a hierarchical clustering (right panel). In between, color-coded
clinical information about the samples, with a legend (bottom left). Data from Nakao et al.
(2004)

3.3.7 Synteny analysis

VAMP can display the syntenic projection of a pro�le onto thegenome of another species, which
serves as a reference; a typical application is the projection of a mouse array-CGH pro�le onto
the human genome (Figure 3.54 ). In such a case, the mouse clones are ordered according to
their mapping onto the human genome. VAMP uses pre-computedinformation mapping each
clone of the sample array onto the reference genome. The synteny relationships can be shown,
for a selection of regions of the genome, as links from each clone of the pro�le to the location
of the most similar sequence of the reference genome. To perform the syntenic projection over
the whole genome or on genomic regions do as described inFigures 3.51 and 3.52.

Figure 3.51: Switch or Add - The user can replace a pro�le by its projection onto another
species genome by usingSynteny ! Switch or he can add the projection below the original
pro�le in the same window by usingSynteny ! Add.

In order to see the links of the syntenic projection perform as described inFigures 3.53
and 3.54.
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Figure 3.52:Add Region Synteny- The user can projects only those clones that are comprised
in the regions he has de�ned by usingSynteny ! Add Region Synteny. Results are shown
in the next �gure.

Figure 3.53: Show Synteny Links - The user can visualize the links of synteny usingCurrent
View ! Show Synteny Links. Results are shown in the next �gure.

Figure 3.54: Synteny visualization - A complete example of visualization of synteny. The
original mouse pro�le is on the top, its projection onto the human genome at the bottom, and
the projection of the clones from the two highlighted regions in the middle, with links from the
mouse-ordered pro�le to the human projection.
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With VAMP it is possible to compare a molecular pro�le with genome annotations, for example
gene structure: the user can load a pseudo-pro�le with the structure of all known genes (introns,
exons, splicing variants). Several functions are o�ered. Proceed as follows:

� import the genome annotation data (seeFigures 3.55 )

� put a landmark on your favorite gene and center on it (seeFigures 3.56 )

Figure 3.55: File ! Import - Start by importing genome annotation data.

Figure 3.56: Genome Annotation - Then you can put a landmark on your favorite gene and
center on it.
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Figure 3.57: Genome Annotation (zoom 3x)

Right-clicking brings up a menu which allows to open web pages from NCBI gene, UCSC
Genome Browser or Ensembl ContigView (seeFigures 3.58 ).

Figure 3.58: Genome Annotation (zoom 30x) (exons in red, introns in yellow, UTR 3' in
light green and UTR 5' in dark green)
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The Histogram of the signal can be computed over the pro�les which are displayed in the current
view (seeFigures 3.59 and 3.60).

Figure 3.59:Tools ! Signal Histogram ! Compute - The user can open a new window of
display signal histogram view.

Figure 3.60: Signal Histogram pro�les - Signal Histogram pro�les view. The values corre-
spond to the ... over the whole dataset from Patil et al. (2005).
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The aim of the di�erential analysis is to compare the signal value of each probe between two
user-de�ned groups of tumors. The user has to perform the following steps:

� First the user must open a new double window (seeFigure 3.61 )

� Then the user load in the top panel the tumors de�ning the �rstgroup (seeFigure 3.62 )

� The tumors de�ning the second group are loaded the bottom panel (seeFigure 3.63 )

� Launch the analysis (seeFigure 3.64 )

Figure 3.61:Views ! New View! Double View ! Point View - First the user must open
a new double window.

Figure 3.62: File ! Import ! in Top Panel - Then the user must loading several pro�les
in the top panel.
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Figure 3.63:File ! Import ! in Bottom Panel - Then the user must loading several pro-
�les in the bottom panel.

Figure 3.64: Tools ! Top Panel ! Differential Analysis ! Compute - The user can
open a new window of dialog for Di�erential Analysis.
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Test: Statistical test is performed using either Student or Welchtest.

Color bars Use sign: If the probe mean of the group in the bottom panel is greater than the
probe mean of the group in the top panel, the bar is displayed in red and otherwise in
green

Color bars Use con�dence: Color bar corresponds to the percentage of pro�les without
missing values

Max P-Value: Probes with a p-value greater than this value are discarded

Multiple testing Benjamini-Hochberg: ajusted p-values using Benjamini-Hochberg method

Multiple testing Benjamini-Yekutieli: ajusted p-values using Benjamini-Yekutieli method

Results: The results are displayed in a pro�le view (seeFigure 3.66 ). The values correspond
to � log1 0p-value

Report: The results are saved in HTML or CSV �le

Figure 3.65: Di�erential Analysis dialog - Di�erent options are available.
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Figure 3.66: Di�erential Analysis pro�les - Di�erential Analysis view.

51



Correlation Analysis aims at quantifying the overall in
uence of DNA copy number changes
on gene expression (gene dosage e�ect) using paired copy number and expression microarray
measurements.

Details on the algorithm and its implementation are given inthe poster we presented at
ISMB 2007:

http://neuvial.ensae.net/data/neuvial07ismb-poster.pdf

Calculating correlations

Assuming that such paired pro�les have been loaded within VAMP (see section 4.4 for an
example), the analysis can be launched from the menuTools ! Correlation Analysis !
Compute:

Figure 3.67: - \Compute" Dialog for Correlation Analysis.

Several parameters can be chosen to run a Correlation Analysis

scope: should correlation coe�cients be calculated on all data or only on selected regions (if
any) ?

criteria: should correlation coe�cients be calculated from copy number ratios, or from smoothed
copy number values given by GLAD ?

correlation: which type of correlation coe�cient should be used ?The Pearson correlation coef-
�cient measures the extent to which the association betweencopy number and expression
is linear; its sensitivity to outliers makes it suitable to detect associations within regions
that are ampli�ed in only few samples. The Spearman correlation coe�cient is the Pear-
son coe�cient between measurements ranks; it is therefore robust to outliers and able to
detect non-linear associations
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The last parameter in Figure 3.67 allows to choose which results should be displayed. The
choice may be made before the analysis is launched, but it canalso be modi�ed (without
further calculations) after the analysis, from the menuTools ! Correlation Analysis !
Redisplay :

Figure 3.68: Tools ! Correlation Analysis ! Redisplay - Correlation Analysis: Redis-
play dialog.

The Redisplay dialog proposes several options:

correlation coe�cient: (default) Pearson or Spearman correlation coe�cient, depending on
the choice made within theComputedialog

p-values: signi�cance level assigned to each correlation coe�cient

FWER: p-values adjusted for multiple comparison in order to control the Family-Wise Error
Rate (FWER), that is, the probability that one or more loci among those selected is a
false positive. We use the Holm adjustment procedure, whichis more powerful that the
traditional Bonferroni procedure

FDR: p-values adjusted for multiple comparison in order to control the False Discovery Rate
(FDR), that is, the expected proportion of false positives among those loci selected

These FWER or FDR multiple testing adjustments may be performed for the whole set of
genes (\whole genome"), or for each chromosome separately (\by chromsome"), leading to a
less conservative adjustment. If only one chromosome is selected, choosing \whole genome" or
\by chromosome" therefore gives exactly the same results.

Importantly, all (adjusted and unadjusted p-values) are displayed in � 10 log-scale, so that
signi�cant genes (with small p-values) can be easily seen. For example, a gene with p-value 10� 7
will be plotted with y = 7. Also note that all p-values are given the sign of the corresponding
correlation coe�cient (which may be negative for some genes).

Exporting the results

The results of the Correlation Analysis cannot be exported yet.
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Figure 3.69: Visualizations of the results of Correlation Analysis. From top to bottom: corre-
lation coe�cients; p-values; FWER-adjusted p-values; FDR-adjusted p-values. All p-values are
plotted in � log10 scale, and given the sign of the corresponding correlation coe�cient.
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Chapter 4

Analysis example - Bladder Cancer

4.1 Introduction

This scenario presents the guidelines to compare the ampli�ed regions obtained in three bladder
cancer datasets (Blaveri et al., 2005; Stransky et al., 2006; Veltman et al., 2003). To run the
interface, you need to con�gure your Java Virtual Machine asexplained at:
http://bioinfo.curie.fr/actudb/Java-con�guration.ht ml
At least 1Gb RAM memory is necessary on your computer.

4.2 Import the genomic pro�les

First, start the VAMP software (La Rosa et al., 2006) from theweb-page:
http://bioinfo.curie.fr/actudb/access.php.
Then, load the array CGH pro�les as follows:

1. click on File ! Import (seeFigure 4.1(a) )

2. select all the pro�les in theCGH ARRAYS/blaveri2005/Arraysdirectory (seeFigure 4.1(b) )

Repeat the previous steps for thestransky2006directory and for the veltman2003directory;
in the veltman2003directory do not select the eight �rst normal array CGH pro�l es.

n.b.: if you wish to import data from one speci�c chromosome (choose Chromosome 6) select
All arraysin the CGH ARRAYS/blaveri2005/Chromosomes/chr06directory (seeFigure 4.1(c) ).

(a) File menu - Import (b) Genome wide pro�le im-
port

(c) Chromosome pro�le im-
port

Figure 4.1: Import Data

The genomic pro�les are displayed in the interface as shown in Figure 4.2 .
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Figure 4.2: Array CGH pro�les

Once all the data have been imported you can display theGained / Lost Color Codes(see
Figure 4.3 ) which corresponds to the alteration calling identi�ed by the GLAD algorithm
(Hup�e et al., 2004): loss regions are in green, normal regions in yellow, gain regions in red and
ampli�ed regions in blue.

Figure 4.3: View menu - Gained / Lost Color Codes

4.3 Minimal Alteration computation

4.3.1 Parameters settings

The minimal alterations or minimal regions of ampli�cation correspond to the intersection
for all tumors of the ampli�ed regions. These regions are minimal in that no breakpoint evidence
is available to narrow the region further. To compute theminimal ampli�ed regions click
on: Tools ! Genome Alteration! Compute(seeFigure 4.4 ).

Then set theGenome Alteration parameters as follows (seeFigure 4.5 ):

1. for the Minimum support of alterations click on Percentand set the value to 5 (we
want that the alteration is present at least in 5% of the samples)
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Figure 4.4: Tools menu - Genome Alteration

2. for the Type of alterations deselectGainand Lossto search only forAmplicon

Figure 4.5: Genome alteration parameters
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Once the search is completed, the minimal ampli�ed regions are displayed as vertical blue lines
(minimal ampli�ed regions are located on chromosomes 6, 8 and 11). In order to see the accurate
location of the regions with respect to the cytogenetic bandings do as follows (seeFigure 4.6 ):

1. in the bottom left corner click onMinimapto display the chromosome image with cytoge-
netic bandings

2. in the main panel mouse over the sample pro�les for chromosome 6, 8 and 11 and you will
see that the minimal ampli�ed regions are highlighted in blue in the minimap panel

Figure 4.6: Minimap and minimal ampli�ed region at 8q22-8q23
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The visualization of the samples which share the minimal ampli�ed regions is available within
the interface:

1. at the top of the panel, click right on the minimal ampli�ed region at 8q22-8q23 and center
on it (seeFigure 4.7(a) )

2. zoom-in in the X and Y scale (seeFigure 4.7(b) )

3. click on View ! Current View! Highlight Minimal Alterations(seeFigure 4.7(c) ): a grey
box will highlight the samples which have the minimal alteration

4. sort the samples which have the minimal ampli�ed region at8q22-8q23 by right-clicking
on this region and then clickingSort CGH arrays(seeFigure 4.7(d) ): all the samples
with the alteration appear at the top of the panel. The same operation can be performed
for ampli�ed regions on chromosome 6 and 11.

(a) Center on mini-
mal ampli�ed region
at 8q22-8q23

(b) Zoom-in in X and
Y scale

(c) View menu - Highlight
Minimal Alterations

(d) Sort CGH Arrays

Figure 4.7: Visualization of the samples with the ampli�cation at 8q22-8q23

4.3.4 Candidate genes

To retrieve the list of genes located in the ampli�ed regionspreviously identi�ed do the following:

1. import in the current view the human gene pro�le (seeFigure 4.8(a) ). It will will be
displayed at the bottom of the main panel

2. scroll down to the bottom of the main panel

3. click on theHuman genepro�le

4. holding the control-keyclick on any other array CGH pro�le

5. in the Tools menu click onTools! Genome Annotation! Gene Selection(seeFigure 4.8(b) )

A dialog box appear and set the parameters as follows (seeFigure 4.8(c) ):

1. for the From parameter selectRegion

2. for the Results parameter selectHTML report and save your �le in gene-list

Now you can open a new web browser window and open the HTML �legene-list.htmlto
visualize all the genes located in the ampli�ed regions (seeFigure 4.9 ).
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(a) Human gene import (b) Tools menu - Genome Annotations

(c) Genome Annotations parameters

Figure 4.8: Candidate gene retrieval

Figure 4.9: Gene list
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In the previous part, the minimal ampli�ed regions have beenidenti�ed and the gene list
retrieved. In Stransky et al. (2006) transcriptome have been studied and these data can be
used to identify among the gene list, the genes which show a signi�cant correlation with respect
to DNA copy number alterations . This will be detailed in whatfollows:

1. open a new view:Views ! New View! Simple View ! Point View

2. import all the chromosome 6 pro�les from thestransky2006directory: File ! Import
(seeFigure 4.4 below)

3. once imported, select all pro�les (Edit ! Select ! All )

4. load transcriptome pro�les associated to the CGH arrays (Tools ! Transcriptome !
Load)

5. start the genome/transcriptome correlation analysis (Tools ! Correlation Analysis
! Compute) with default parameters

Figure 4.10: Importing array-CGH pro�les

A new window opens where correlations are displayed along chromosome 6: the highest
correlation is 0.88 and correspond to the 41632AT probe located at 6p22. Right-clicking on
this probe allows to have an external link to the Genecards database (seeFigure 4.11(a) ):
this probe correspond to the E2F transcription factor 3.

Go back to the previous view with the 196 genome-wide pro�lesand click onSearch Elements
on the top left panel and do the following (seeFigure 4.11(b) ):

1. selectGeneSymbolin the drop-down menu

2. type E2F3 in the right box
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4. wait for the search to be completed (it may take few seconds)

5. zoom-in in the X and Y scale (seeFigure 4.7(b) ) until to see the E2F3 gene structure
(seeFigure 4.11(c) )

The E2F3 gene is located in the ampli�ed region previously detected.

(a) External links - Genecards (b) Search panel - E2F3 (c) E2F3 gene structure - Introns are
in yellow, exons in red and 3' UTR
in green

Figure 4.11: E2F3 is correlated with DNA copy number
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Chapter 5

Analysis example - Colon Cancer

5.1 Introduction

This scenario presents the guidelines to compare the frequency of alterations obtained in two
colorectal cancer datasets (Douglas et al., 2004; Nakao et al., 2004). To run the interface, you
need to con�gure your Java Virtual Machine as explained at:
http://bioinfo.curie.fr/actudb/Java-con�guration.ht ml
At least 1Gb RAM memory is necessary on your computer.

5.2 Import the genomic pro�les

First, start the VAMP software (La Rosa et al., 2006) from theweb-page:
http://bioinfo.curie.fr/actudb/access.php.
Then, load the array CGH pro�les as follows:

1. click on File ! Import (seeFigure 5.1(a) )

2. select all the pro�les in theCGH ARRAYS/douglas2004/Arraysdirectory (seeFigure 5.1(b) )

n.b.: if you wish to import data from one speci�c chromosome select:
CGH ARRAYS/douglas2004/Chromosomes/chr..(seeFigure 5.1(c) )

(a) File menu (b) Genome wide
pro�le import

(c) Chromosome pro-
�le import (optional)

Figure 5.1: Import Data

The genomic pro�les are displayed in the interface as shown in Figure 5.2 .
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Figure 5.2: Array CGH pro�les

Open a new view (seeFigure 5.3 ) and repeat the previous steps for thenakao2004directory.

Figure 5.3: View menu - New view

5.3 Frequency alteration computation

5.3.1 Computation for each dataset

For each dataset compute thefrequency of alterations by clicking onTools! FrAGL! Compute
(seeFigure 5.4(a) ). Then set the FrAGL parameters as follows (seeFigure 5.4(b) ):

1. click onStatus(the alteration calling identi�ed by the GLAD algorithm (Hu p�e et al., 2004)
is used)

2. for the Minimum value of con�dence click on Percentand set the value to 20 (probe
with a missing value percentage greater than 20 are discarded from the analysis)

Once this procedure has been performed for both Douglas et al. (2004) and Nakao et al.
(2004) two new windows are displayed with the frequency of alteration (seeFigure 5.5 ).
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(a) Tools menu - FrAGL (b) FrAGL parameters

Figure 5.4: Frequency of alterations computation

5.3.2 Comparison of the frequency between the two datasets

To compare the two FrAGL pro�les obtained in the previous step for each datasets proceed as
follows:

1. in the �rst FrAGL view select and copy the pro�le (seeFigure 5.6(a) )

2. in the second FrAGL view paste the pro�le (seeFigure 5.6(b) )

The comparison in now possible in the �nal view as shown inFigure 5.7 .
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Figure 5.5: Frequency of alterations the Douglas et al. (2004) dataset.

(a) Edit menu - Select and copy (b) Edit menu - Paste

Figure 5.6: Comparison of the two FrAGL pro�les

66



Figure 5.7: Comparison of the frequency of alteration for Douglas et al. (2004) (top pro�le) and
Nakao et al. (2004) (bottom pro�le) datasets.
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Chapter 6

Availability

VAMP is available upon request to vamp@curie.fr. It can be tested on public data sets at the
following url: http://bioinfo.curie.fr/vamp.

VAMP is also integrated into CAPweb, a complete bioinformatics pipeline for array-CGH
data analysis. CAPweb can be tested at the following url: http://bioinfo.curie.fr/CAPweb

Note that some movies present as well the main functions of VAMP for basic functions, data
Analysis, synteny analysis: http://bioinfo.curie.fr/va mp/doc
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Chapter 7

How to cite us?

If you used VAMP please cite us as follows:
La Rosa et al. (2006). VAMP: Visualization and Analysis of CGH arrays, transcriptome

and other Molecular Pro�les. Bioinformatics, 22:2066-73.
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Chapter 8

Annexes

8.1 Main con�guration XML �le
<Parameter key="min:memory" value="200"/> : minimum size for a standard use (a message is displayed if the user memory i s below this threshold)
<Proxy host='www-cache' port='1234'/> : proxy address for the URL

<TranscriptomeURLTemplate>
file:///C:/VAMP/data/xml/trs/#ProjectId#/#NumHisto# /chr/chr#ChrAlias#.xml
</TranscriptomeURLTemplate>
Used for locating the transcriptome data from a CGH array (#v ariables# are set from the XML CGH array data files)

<LOHURLTemplate>
file:///C:/VAMP/data/xml/microsat/#ProjectId#/#NumH isto#/chr/chr#ChrAlias#.xml
</LOHURLTemplate>
Used for locating the LOH data from a CGH array (#variables# a re set from the XML CGH array data files)

Parameterization of the contextual menu of an object of Clon e type: how to add an hypertext link:
<PropertyElementMenu object='DataElement' type='Clone '>
<MenuItem type='separator'/>
<MenuItem type='menu' title='External Links'>

<MenuItem
type='url'
title='NCBI Clone Viewer'

url='http://www.ncbi.nlm.nih.gov/genome/clone/clnam e.cgi?stype=Name&amp;list=#Name#'
target='_blank'/>

<MenuItem
type='url'
title='NCBI Map Viewer'

url='http://www.ncbi.nlm.nih.gov/mapview/maps.cgi?O RG=hum&amp;query=#Name#&amp;MAPS=cntg-r,clone,sts,genes,comp&amp;CHR=#Chr#&amp;ABS_ZOOM=6M'
target='_blank'/>

<MenuItem
type='url'
title='Working Draft (UCSC)'

url='@data'
target='_blank'>

<token>
http://www.genome.ucsc.edu/cgi-bin/hgTracks?positio n=chr#Chr#:</token>
<sub>
<property>Position</property>
<token>150000</token>
</sub>
<token>-</token>
<add>
<property>Position</property>
<token>150000</token>
</add>

</MenuItem>
<MenuItem

type='url'
title='Ensembl ContigView'

url='@data'
target='_blank'>

<token>
http://www.ensembl.org/Homo_sapiens/contigview?chr= #Chr#&amp;vc_start=</token>
<sub>
<property>Position</property>
<token>150000</token>
</sub>
<token>&amp;vc_end=</token>
<add>
<property>Position</property>
<token>150000</token>
</add>

</MenuItem>
<MenuItem

type='url'
title='Ensembl CytoView'

url='@data'
target='_blank'>

<token>
http://www.ensembl.org/Homo_sapiens/cytoview?chr=#C hr#&amp;vc_start=</token>
<sub>
<property>Position</property>
<token>150000</token>
</sub>
<token>&amp;vc_end=</token>
<add>
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</add>
</MenuItem>

</MenuItem>
</PropertyElementMenu>

Parameterization of the contextual menu of an object of Prob eSet type: how to add an hypertext link:
<PropertyElementMenu object='DataElement' type='Probe Set'>
<MenuItem type='separator'/>
<MenuItem type='menu' title='External Links'>

<MenuItem
type='url'
title='Genecards Viewer'

url='http://genecards.curie.fr/cgi-genecards/cardse arch.pl?search=#SourceID#'
target='_blank'/>

</MenuItem>
</PropertyElementMenu>

Parameterization of the contextual menu of the "Minimap: ho w to add an hypertext link:
<PropertyElementMenu object='MiniMapChr'>

<MenuItem type='menu' title='External Links'>
<MenuItem

type='url'
title='NCBI Map Viewer'

url='http://www.ncbi.nlm.nih.gov/mapview/maps.cgi?O RG=human&amp;MAPS=cntg-r,clone,sts,genes,comp&amp;CHR=#Name#'
target='_blank'/>

</MenuItem>
</PropertyElementMenu>

<PropertyElementMenu object='MiniMapBand'>

<MenuItem type='menu' title='External Links'>
<MenuItem

type='url'
title='NCBI Cancer Chromosomes'
url='http://www.ncbi.nlm.nih.gov/entrez/query.fcgi? db=cancerchromosomes&amp;term=%2B#Chr##Arm##Name#&amp;cmd=Search'
target='_blank'/>

</MenuItem>
</PropertyElementMenu>

<UserDocumentation url='...'/> : indicates the physical l ocalization of the user's guide

several examples of how to call a cgi (does not function local ly) :
<Parameter key="eXcel:URL" value="http://bioinfo.curi e.fr/cgi-bin/cghaia/export.pl?format=xl"/>
<Parameter key="eXcelChrAvg:URL" value="http://bioinf o.curie.fr/cgi-bin/cghaia/average_chr.pl?format=xl" />
<Parameter key="cluster:URL" value="http://bioinfo.cu rie.fr/cgi-bin/cghaia/vamp_plugin.pl?action=clust"/ >

root of the physical localization of the data xml files :
<Parameter key="importData:baseURL" value="file:///C: /VAMP/data/xml/cgh/"/>

indicates the physical localization of the image file which are used by the applet :
<Parameter key="applet_home_img:URL" value="file:///C :/VAMP/images/applet_home.png"/>
<Parameter key="cytoband:URL" value="file:///C:/VAMP/ data/xml/cytoband/human"/>
<GraphElementIcon type="CGH Array" url="file:///C:/VAM P/images/vamp_cgh.jpg"/>
<GraphElementIcon type="CGH Chromosome Merge" url="file :///C:/VAMP/images/vamp_cgh.jpg"/>
<GraphElementIcon type="CGH Array Merge" url="file:///C :/VAMP/images/vamp_cgh.jpg"/>
<GraphElementIcon type="CGH Average" url="file:///C:/V AMP/images/vamp_cgh.jpg"/>
<GraphElementIcon type="Transcriptome" url="file:///C :/VAMP/images/trs.jpg"/>
<GraphElementIcon type="Transcriptome Average" url="fi le:///C:/VAMP/images/trs.jpg"/>
<GraphElementIcon type="Transcriptome Relative" url="f ile:///C:/VAMP/images/trs.jpg"/>
<GraphElementIcon type="Transcriptome Merge Relative" u rl="file:///C:/VAMP/images/trs.jpg"/>
<GraphElementIcon type="LOH" url="VAMP/images/LOH.jpg "/>

indicates the physical localization of cytogenetics descr iptions :
<Cytoband organism="Human"

url="file:///C:/VAMP/data/xml/cytoband/human/mai_20 04"
resolutions="400:550:850"
default_resolution="400"/>

<Cytoband organism="Mouse"
url="file:///C:/VAMP/data/xml/cytoband/mouse"
resolutions="400"/>

indicates the physical localization of a file used for custo mized printing of a reporting :
<PrintPageTemplate url="file:///C:/VAMP/configuratio n/xml/print-report.xml"/>

8.2 Sample user con�guration XML �le
<?xml version='1.0' encoding='iso-8859-1'?>
<CGHConfig>
<AxisBG>ORANGE</AxisBG>
<AxisEastSize>40</AxisEastSize>
<AxisFG>BLACK</AxisFG>
<AxisKaryoDisplayerFont>MonoSpaced:PLAIN:8</AxisKar yoDisplayerFont>
<AxisKaryoNameDisplayerFont>Serif:BOLD:9</AxisKaryo NameDisplayerFont>
<AxisKaryoSmallDisplayerFont>MonoSpaced:BOLD:7</Axi sKaryoSmallDisplayerFont>
<AxisLabelFG>BLACK</AxisLabelFG>
<AxisLineFG>LIGHT_GRAY</AxisLineFG>
<AxisNorthSize>45</AxisNorthSize>
<AxisSouthSize>40</AxisSouthSize>
<AxisTranscriptomeFG>GRAY</AxisTranscriptomeFG>
<AxisTranscriptomeLabelFG>GRAY</AxisTranscriptomeLa belFG>
<AxisTranscriptomeLineFG>BLUE</AxisTranscriptomeLin eFG>
<AxisTranscriptomeReferenceFG>770033</AxisTranscrip tomeReferenceFG>
<AxisTranscriptomeReferenceLabelFG>770033</AxisTran scriptomeReferenceLabelFG>
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<AxisTranscriptomeRelativeLabelFG>GRAY</AxisTranscr iptomeRelativeLabelFG>
<AxisWestSize>90</AxisWestSize>
<AxisXDisplayerFont>Serif:PLAIN:9</AxisXDisplayerFo nt>
<AxisYCanvasPropertyNameFG>BLACK</AxisYCanvasPropertyNameFG>
<AxisYDisplayerFont>Serif:PLAIN:9</AxisYDisplayerFo nt>
<AxisYNameDisplayerFont>Serif:PLAIN:9</AxisYNameDis playerFont>
<AxisYPropertyNameFG>BLUE</AxisYPropertyNameFG>
<BreakpointDashPadding>2</BreakpointDashPadding>
<BreakpointDashWidth>2</BreakpointDashWidth>
<BreakpointFG>RED</BreakpointFG>
.
.
.
<SeachPanelBG>ORANGE</SeachPanelBG>
<SearchPanelButtonBG>WHITE</SearchPanelButtonBG>
<SearchPanelButtonFont>SansSerif:PLAIN:9</SearchPan elButtonFont>
<SmoothingLineFG>BLACK</SmoothingLineFG>
<SmoothingPointFG>BLACK</SmoothingPointFG>
<SmoothingPointWidth>2</SmoothingPointWidth>
<TabBG>WHITE</TabBG>
<TabbedPaneFont>MonoSpaced:BOLD:10</TabbedPaneFont>
<ThresholdMaxYFG>RED</ThresholdMaxYFG>
<ThresholdMinYFG>GREEN</ThresholdMinYFG>
<ThresholdPanelBG>ORANGE</ThresholdPanelBG>
<ThresholdPanelButtonBG>WHITE</ThresholdPanelButton BG>
<ThresholdPanelLabelFont>SansSerif:PLAIN:9</Thresho ldPanelLabelFont>
<Threshold_CGH_MaxY>2.8</Threshold_CGH_MaxY>
<Threshold_CGH_MinY>0.01</Threshold_CGH_MinY>
<Threshold_ChIP-chip_MaxY>16.0</Threshold_ChIP-chip _MaxY>
<Threshold_ChIP-chip_MinY>0.01</Threshold_ChIP-chip _MinY>
<Threshold_SNP_MaxY>8.0</Threshold_SNP_MaxY>
<Threshold_SNP_MinY>0.1</Threshold_SNP_MinY>
<Threshold_TRSREL_MaxY>10.0</Threshold_TRSREL_MaxY>
<Threshold_TRSREL_MinY>0.25</Threshold_TRSREL_MinY>
<Threshold_TRS_MaxY>5000.0</Threshold_TRS_MaxY>
<Threshold_TRS_MinY>-10.0</Threshold_TRS_MinY>
<TitlePanelBG>ffffd0</TitlePanelBG>
<TranscriptomeMergeColorBase>WHITE</TranscriptomeMe rgeColorBase>
<Utr3FG>ee00</Utr3FG>
<Utr5FG>6600</Utr5FG>
<UtrHeight>2</UtrHeight>
<ViewBG>WHITE</ViewBG>
<ZoomPanelBG>ORANGE</ZoomPanelBG>
<ZoomPanelLabelFont>SansSerif:PLAIN:9</ZoomPanelLab elFont>
<ZoomPanelTextFieldFont>SansSerif:PLAIN:10</ZoomPan elTextFieldFont>
<PropertyAnnotations>
</PropertyAnnotations>
</CGHConfig>

8.3 Import XML �le
<?xml version='1.0' encoding='iso-8859-1'?>
<FolderSet>
<Folder label="CGH ARRAYS (Team : public)">
<Folder label="snijders">
<Folder label="Arrays" type="CHR_ARRAY">
<Item label="gm00143" url="public/snijders/array/gm00 143.xml"/>
<Item label="gm01524" url="public/snijders/array/gm01 524.xml"/>
.
.
.
<Item label="gm13031" url="public/snijders/array/gm13 031.xml"/>
<Item label="gm13330" url="public/snijders/array/gm13 330.xml"/>
</Folder>

<Folder label="Chromosomes">
<Folder label="chr01" type="CHR">
<Item label="All arrays" url="public/snijders/chr/chr0 1.xml"/>
<Item label="gm00143" url="public/all/chr01/gm00143.x ml"/>
<Item label="gm01524" url="public/all/chr01/gm01524.x ml"/>
.
.
.
<Item label="gm13031" url="public/all/chr01/gm13031.x ml"/>
<Item label="gm13330" url="public/all/chr01/gm13330.x ml"/>
</Folder>
<Folder label="chr02" type="CHR">
<Item label="All arrays" url="public/snijders/chr/chr0 2.xml"/>
<Item label="gm00143" url="public/all/chr02/gm00143.x ml"/>
<Item label="gm01524" url="public/all/chr02/gm01524.x ml"/>
.
.
.
<Item label="gm13031" url="public/all/chr02/gm13031.x ml"/>
<Item label="gm13330" url="public/all/chr02/gm13330.x ml"/>
</Folder>
<Folder label="chr03" type="CHR">
<Item label="All arrays" url="public/snijders/chr/chr0 3.xml"/>
<Item label="gm00143" url="public/all/chr03/gm00143.x ml"/>
<Item label="gm01524" url="public/all/chr03/gm01524.x ml"/>
.
.
.
<Item label="gm13031" url="public/all/chr03/gm13031.x ml"/>
<Item label="gm13330" url="public/all/chr03/gm13330.x ml"/>
</Folder>

</Folder>
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</FolderSet>

8.4 CGH array XML �le
<?xml version='1.0' encoding='iso-8859-1'?>
<ArraySet>

<SetName>gm01535</SetName>
<Array>

<Team>public</Team>
<Organism>Human</Organism>
<Project>snijders</Project>
<ProjectId>15</ProjectId>
<NumHisto>4948</NumHisto>
<SampleAdditionalData URL="additional/snijders/gm015 35.xml"/>
<Chr>1</Chr>
<Name>gm01535</Name>
<Date>Thu Apr 7 16:14:54 2005</Date>
<Type>CGH</Type>
<ObjKey>Name</ObjKey>
<NbSpot>6813</NbSpot>
<NbRep>3</NbRep>
<RatioScale>L</RatioScale>
<Url>public/all/chr01/gm01535.xml</Url>
<NbObj>2271</NbObj>
<Obj>

<Properties>
<Type>Clone</Type>

<Y>NA</Y>
<X>1000</X>
<Chr>1</Chr>
<Name>GS1-232B23</Name>
<Smt>NA</Smt>
<Bkp>NA</Bkp>
<Out>NA</Out>
<Gnl>NA</Gnl>

</Properties>
</Obj>
<Obj>

<Properties>
<Type>Clone</Type>

<Y>0.009421</Y>
<X>468000</X>
<Chr>1</Chr>
<Name>RP11-82d16</Name>
<Smt>0.0193950</Smt>
<Bkp>0</Bkp>
<Out>0</Out>
<Gnl>0</Gnl>

</Properties>
</Obj>
<Obj>

<Properties>
<Type>Clone</Type>

<Y>-0.021783</Y>
<X>2241000</X>
<Chr>1</Chr>
<Name>RP11-62m23</Name>
<Smt>0.0193950</Smt>
<Bkp>0</Bkp>
<Out>0</Out>
<Gnl>0</Gnl>

</Properties>
</Obj>

.

.

.
</Array>

</ArraySet>

8.5 Transcriptome array XML �le
<?xml version='1.0' encoding='iso-8859-1'?>
<ArraySet>

<SetName>chr1</SetName>
<Array>

<Organism>Human</Organism>
<Project>pollack</Project>
<ProjectId>pollack</ProjectId>
<NumHisto>NORWAY_7</NumHisto>
<Chr>1</Chr>
<Name>NORWAY_7_EXPR</Name>
<Date>28/04/2004</Date>
<Type>TRS</Type>
<Url>trs/pollack/NORWAY_7/all/chr1/NORWAY_7_EXPR.xml</Url>
<Obj>

<Properties>
<Type>ProbeSet</Type>
<ObjectId>IMAGE:322807</ObjectId>
<Signal>-0.88</Signal>
<PosBegin>13850</PosBegin>
<PosEnd>14650</PosEnd>
<Size>800</Size>
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</Properties>
</Obj>
<Obj>

<Properties>
<Type>ProbeSet</Type>
<ObjectId>IMAGE:190915</ObjectId>
<Signal>-0.03</Signal>
<PosBegin>167764</PosBegin>
<PosEnd>168564</PosEnd>
<Size>800</Size>
<Source>IMAGE</Source>
<SourceID>190915</SourceID>

</Properties>
</Obj>
.
.
.

</Array>
</ArraySet>
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